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I. Introduction 

Designing a natural gas or propane system for installation into a home or commercial building is 
not a trivial project. You must design your system within allowable pressure drops to deliver the 
required gas pressure at the appliance based on a given supply pressure. If too low or too high the 
appliance may not operate properly. 

In addition, building codes and manufacturer specifications require that you size pipes properly 
using standard industry methods to assure these requirements are met.  If an error is made using 
one of these methods, you may undersize your piping causing equipment issues, or oversize your 
piping costing you money. 

TracPipe Specifier 2 solves these problems for you. After you lay out a system, it checks your 
system for errors and calculates the minimum required pipes sizes using the Branch Length 
Method (BLM). Optionally, you may optimize the design using the Sum of Pressure Loss (SOPL) 
engineering method. 

 
II. The Design Process 

TracPipe Specifier 2 is a Computer Aided Design (CAD) system. You draw your system design 
schematically on a virtual piece of paper, first specifying the gas source, then adding pipes, fittings, 
regulators (in elevated pressure systems), and appliances in a drawing and connecting them 
together. Then TracPipe Specifier 2 checks your design for errors and calculates the sizes of pipes 
in your system. When regulators are specified for elevated pressure systems (above ½ psi), it will 
assign regulator part numbers. You may print your design as an engineering drawing, and/or export 
the calculated data. The program will create a Bill Of Materials (BOM) and sum up the different 
types and sizes of piping. Lastly, you may change various attributes of your design to further 
optimize it. 

To start, you are presented with a virtual piece of paper, to place your design. You can pan the 
paper up, down and sideways, as well as zoom it in and out. On the paper, you place the gas source, 
pipes, pipe fittings, regulators and appliances on the drawing, connect them together using the 
tools provided, and then print them out. 

 
III. Features 

 • Virtual piece of paper. You may pan and zoom the paper in the drawing window. The virtual 
paper is scaled to fit the paper size you specify for printing. 

 • Unlimited undo/redo stack of all changes to a design. This allows easy correction of mistakes 
as well as experimentation. 
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 • You may specify initial system parameters (supply pressure and pressure drop), which creates 
a gas source. You then place appliances, pipe fittings, such as manifolds, and regulators in a 
design and connect them with pipes. Several drawing methods allow you to use the one that 
works best for you. 

 • Design natural gas and propane gas systems for low, medium and elevated pressure systems. 
Multiple gas sources may be specified for complex systems. 

 • Specify TracPipe (yellow jacket), Counterstrike (black jacket), TracPipe PS-II (underground 
gas piping) and rigid SCH 40 steel pipe (Black Iron or Galvanized). 

 • Extensive drawing flexibility. You may freely move around objects, scale appliances, rotate 
fittings, and reconnect pipes to your heart’s content. Object properties can be adjusted. All 
objects have optional labels with font attributes.  

 • Be able to save as a .tracPipe2 file and reopen and revise it at any time. 
 • Very fast. You can specify simple to complex designs. 
 • Pipe sizing uses the Branch Length Method, after doing extensive error checking. You may 

use the Sum of Pressure Loss (SOPL) method for more precise calculations and to further 
optimize your design. 

• Continually performs pipe sizing calculations as you work. It highlights incomplete areas of 
your design and fills in sizes when you design is complete. 

 • Suggests part numbers for regulators if available. 
 • Easy to install applications for Macintosh® and Windows. 
 • Reads and converts legacy TracPipe Specifier .tps files to allow working on old designs. 
 • A design can be turned into an Engineering drawing by specifying an engineering template. 

This may include Bills of Materials, Sum of Pressure Loss reports, Title Blocks, notes, images 
and .pdf documents right on the drawing. 

 • Designs can be opened on either Microsoft Windows® or Apple Macintosh® platforms. Files 
are compatible across systems. 

• Dark mode is supported on Macs. 

Advantages over the previous TracPipe Specifier for Windows 
 • Updated to a more modern application design. Menu bar has been added with additional 

commands available and keyboard equivalents. 
 • Multiple drawing methods are possible. 
 • Design may be zoomed and panned. Appliances may be scaled and fittings rotated or flipped. 

A design can be turned into an engineering drawing. 
 • Infinite undo/redo. Cut, copy and Paste are available. 
 • There are many different pipe types, pipe fittings, and many more appliance types to choose 

from. Additional objects will be added over time. 
 • Pipes are separate from other objects. Extensive reconfiguration is possible without having to 

go back and recreate things. For example, you can add a tee into the middle of a system 
without deleting all the components downstream of the tee. 

 • Uses Branch Length and Sum of Pressure Loss sizing methods for more optimum designs. 
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IV. Quick Start 
• There are versions of TracPipe Specifier 2 for machines running Microsoft Windows® 

version 7 onwards and MacOS® versions 10.13 onwards. Because the user interface to both 
versions is almost identical this guide is applicable to both versions. With exceptions, most 
screenshots here are from the Windows version. Where there are differences, Windows 
specific notes are preceded by Win: and MacOS specific notes by Mac:. In general, where 
is says to use the Ctrl key for Windows, use the Command key, “⌘”, on the Mac. 

 • Win: If TracPipe Specifier 2 has not been previously installed on your Windows computer, 
download the Install TracPipe Specifier 2.msi file from the Omega Flex website or 
http://www.tracpipe.com. Double click on the file to initiate the install or update process and 
agree to the EULA before continuing. To uninstall, you may double click on the installer file 
again or use the Programs and Features control panel in Windows. 

  Mac: If TracPipe Specifier 2 Mac has not been previously installed on your Macintosh 
computer, download the TracPipe Specifier 2 Mac Installation.dmg file from the Omega 
Flex website or http://www.tracpipe.com. Double click on the file to open it in the Finder. 
You should see a window in the Finder like this: 

 
  To install the application, Drag the TracPipe Specifier 2 Mac.app file onto the folder 

named Applications. This will copy the program onto the Applications folder on your boot 
hard drive. Drag the Using TracPipe Specifier 2 Rev 8-8-19.pdf file to the folder where 
you keep your program documentation on your computer. 

 • Win: Launch TracPipe Specifier 2. It is listed in the Start button under Omega Flex, Inc. 
Mac: Locate TracPipe Specifier 2 Mac in your Applications folder or use Spotlight to 
search for it. Double-click on the application to launch it. 

 • If TracPipe Specifier 2 had been used previously, the last design used will open. Click on the 
“New” icon to start a new design. 

 
 • Otherwise, TracPipe Specifier 2 will start a new drawing automatically. 
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  If you want to open a previous .tracPipe2 document, double-click on the file in a File 
Explorer window or use the Open (Ctrl O) command. If the Gas Source Properties dialog is 
showing, cancel it first. 

 • If a new drawing, you will be presented with a dialog to specify the gas source of the system. 
Select Natural Gas or Propane. Select the pressure supply range (low, medium, or elevated) 
of your system. Select the actual combination of Gas Pressure and Pressure Drop of your 
system from the dropdown list. You may have to adjust the supply system pressure range to 
find the appropriate entry. 

  Systems with Elevated gas pressure utilize inline regulators to drop the pressure to a value 
appliances can handle. You may specify the output pressure for such regulators on an elevated 
system. 

 
 • The drawing window will open showing either a gas meter or the propane supply pressure 

regulator for the gas source. 
 • On the gas source and other unconnected objects you will see dots that are connection points 

where you can connect pipes, appliances, pipe fittings like manifolds, and regulators on  
elevated pressure systems. You only connect appliances, fittings, and regulators to pipes, not 
to each other directly. 

 
Right Click Method 
 • Right click on a connection point on the initial gas source. Select “Pipe”.  
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 • Move the mouse to the right and down to where you want the pipe to end and click. 

 
You will be presented with a little dialog that will ask you what attributes you want for a pipe. 
 

 
  Select the pipe type, usually CounterStrike, and specify the length of the pipe in feet. The pipe 

type will be remembered for next time. Click OK. Pipe Dia. is for existing pipes in legacy 
systems or for forcing explicit sizes. 

 • Now, right click on the end of the pipe and select an appliance. 
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 • You’ll get an Appliance Specifier Specify its load in MBTU (thousands of BTU) energy units 
and click OK and you’ll now have a small, but complete gas system. The objects in the system 
will be labeled. 

 
 • To complete the initial design we’ll want to add a Bill of Materials and the Size the system. 

Next click on the Draw Menu button, and select BOM Chart. (We’ll discuss the Title Block 
later.) 

 
  Then click in the drawing where you’d like to place it. 

 
  Because of automatic sizing, the pipe diameter will be calculated and the Bill of Material 

List will be filled in. 

 
 • Optionally, click on the Calculate Pipe Sizing button. If everything is connected it will alert 

you that no errors were found. If there is a problem, it will present an error message. 

 
 • Finally click on the Save icon, or select File->Save and save your design so you don’t lose 

your work. 

Expanding the Design 
Let’s add a manifold and a couple of additional appliances to show how easy it is to modify a 
design. 
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 • Click on the Cooktop and drag it down to make room for additional appliances. 

 
  You’ll notice that the Cooktop becomes selected. Resize handles appear so you can resize the 

size of the appliances in the drawing, if you desire. Double click on the cooktop to get a 
Properties Panel to show properties of the cooktop so you can alter them. 

 • Right click in the space above the cooktop and select Fittings->Manifold. A manifold will 
appear where you clicked the mouse. A popup dialog will let you select the number of ports 
and the orientation of the manifold— down, up, right, or left, based on the direction of the 
outlet ports. 

 
 • Now you can move the pipe that connects to the cooktop and connect it to the manifold. Then 

you can add a new pipe from the manifold to cooktop. 
  Click on the end of the pipe that connects to the appliance and drag it to the manifold input 

until its connection point turns red, indicating the pipe has snapped to it. 

 
 • Now right click on the left hand manifold output and select pipe. Drag the pipe to the cooktop 

reconnect it to the system. You’ll notice that the B.O.M. now has the added pipe. 
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 • Now we will add another couple of appliances, By right clicking on connection points or using 

the appropriate drawing tools in the menus or menu bar. More pipes are added to the B.O.M. 

 
 
 • Automatic resizing will update the calculations. 

 
 • If something is not connected correctly, you’ll see a dashed pipe, or an object shown in red. 

This shows that something is wrong. Click on the resize button to see an error message 
describing the specific problem. 

Advanced Pipe Drawing Techniques 
Pipes, as shown in the design, are not drawn to scale, but when drawing pipes, there are some 
advanced features that allow you more control over their appearance. These control in what 
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direction a pipe is drawn, or to add additional bends to a pipe to allow it to follow a more complex 
path. 

Some of these are a little tricky and it may take a little practice to get right. Once you learn them, 
you’ll be more efficient at drawing pipes, particularly fancy ones. 
 • When you first draw a pipe, it can start off horizontally or vertically. The direction it starts off 

in depends on what direction you move the mouse. 
  If you first move the mouse to the left or right, the pipe starts off horizontally. Move it up or 

down and the pipe starts off vertically. You must move the mouse a bit to get the pipe to snap 
to that direction. 

  For example, after moving the mouse horizontally: 

   
  Or vertically. 

   
 • Usually, the pipe tool adds an automatic bend in a pipe to reach its final destination, so that 

pipes are always horizontal or vertical lines (indirect pipes). If you like the pipe to go directly 
from the source to the destination (direct pipes) hold the control key down as you more the 
mouse. This will make the pipe draw at an angle, and not add any addition bends to it like so: 

   
 • You can add addition bends to a pipe, for example if the pipe is going a long distance and 

other objects are on the design. To add a bend, hold the shift key and click where you want 
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the bend to appear. Since for indirect pipes, the program adds an additional bend at the end, 
you don’t need to shift-click for the last bend. 

   
  If you want the previous section to be direct, control-shift-click to make it direct and start a 

new section of pipe. After drawing an indirect section, the direction of the next section is 
again determined by what direction you next move the mouse. By shift-clicking or control-
shift-clicking you and make a pipe with lots of sections to it, some orthogonal and some direct. 

   
 • It is easy to make a mistake while your drawing multiple sections, but you don’t have to start 

all over. Hit the escape key to undo the last section of pipe you are drawing. Each key press 
backs you up a section until there is no pipe left. 

   
 • After you draw a pipe, you can adjust it using the select tool. If you move the mouse over a 

multi-bend pipe, you see middle sections highlight. If a section is highlighted, you can click 
on it and move it around, horizontally for vertical sections, vertically for horizontal sections, 
or any direction for  direct sections—ones at an angle. To move the first or last section of a 
pipe, move the appliance it is connected to, or its end point. 

   
 • You can make an orthogonal pipe that is just horizontal or vertical and no bends—a little odd, 

since they won’t actually connect to a destination device, but you can later drag or paste a 
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device there later. Win: Hold the alt key down when you draw. Note that under Windows, 
the alt key is sticky. You have to tap it again to remove it. Mac: Use the option key. It is not 
sticky. 

 • You can draw pipe by right clicking on a connection point, or in an empty part of the drawing 
and select “pipe” from the pulldown. Instead, you can click on the pipe tool on the tool bar 
or select pipe from the Draw menu. If you’d like to draw multiple pipes at once, hold down 
the shift key, when you select the pipe tool so that you stay in the pipe tool until you select a 
different tool, or escape out of it. 

Using Cut, Copy, Paste 
You can use the Cut, Copy, and Paste commands to remove, move, or copy elements of a design, 
even whole sections. The commands are under the Edit menu on the menu bar and when you right 
click in the drawing or on objects. 

 
 • The place where objects are stored when you Cut or Copy them is call the paste buffer. The 

paste buffer is preserved between drawing loads, and in fact, between launches of TracPipe 
Specifier 2. It remains until you cut or copy something else into it, including when in other 
applications. 

 • When you use Cut or Copy, all items selected are copied there. After a Cut the items are 
deleted from the design. Undo will get them back, but does not undo the paste buffer. 

 • The Select tool allows for multiple selection. With the select tool, you can click in space and 
draw a rectangle to highlight multiple items that fall completely or partially in the rectangle. 
You may also add or remove items from the selected set by holding the shift key when you 
select them. 

   
  To select a pipe, you must select the objects on both ends, or click on the pipe directly. 
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 • Paste recognizes objects cut or copied from TracPipe Specifier 2 designs and also plain text 

copied from other software. If from a design, the objects are pasted as is. If it is plain text, a 
text element is created with the text in it. This is an easy way to paste in text from other 
applications. Currently, images or .pdf documents from other programs in the paste buffer are 
not recognized. But you may copy and paste image and PDF objects that are already included 
in this or other TracPipe Specifier 2 designs. 

 • If you use the Paste command under the Edit menu, the contents of the paste buffer are pasted 
in the center of your current view of the design. If you right click in space and select Paste, 
the paste buffer will be pasted centered on where you clicked in the drawing. 

 • If you right click on a connection point on a pipe, appliance, or pipe fitting, paste attempts to 
connect whatever is in the paste buffer to where you clicked, if it makes sense. For example, 
if you copied an appliance with a connecting pipe, and you paste on a pipe fitting, it will 
connect the incoming pipe to the connection point automatically. If you copied an appliance, 
and click on the open end of a pipe, it will automatically connect the appliance to the pipe. 

 • If it can’t figure out how to make a connection, paste will simply center the pasted objects 
where you clicked the mouse. 

 • If you don’t like how the paste went, you may simply undo it. 
 • Doing a paste, does not clear the paste buffer. You can copy something there and do multiple 

pastes, to make quick duplicates of them. This includes gas sources, like meters and propane 
sources. 

Adding some Additional Text to the Design 
We can add additional free-standing text and other information to the design. 

 • To add a line or two of text, Click on the “T” icon, . As you move the mouse over the 
design, you’ll see some floating text. 

 

   
 
  Click once! A Text Properties dialog will come up. Specify one to a few lines of short text.  
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   When you Click OK, you’ll see your lines of text with a resize handle on each side of the text, 

like so… 

   
 
  Drag a resize handle to expand or shrink the text, like so: 
 

   
 
   Double-click on a piece of text in a drawing to bring up its properties. 

 • You can add whole paragraphs or lists as text. Again, click on the “T” icon, . As you move 
the mouse over the design, you’ll see the floating text. 

 

   
  Now, click and drag a rectangle, instead of just a single click. A rectangle will drag out, like 

so: 
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  Paste in a paragraph or list in the Text Properties dialog and click OK. 

   
  And you’ll see the text with handles, but the text will now be confined to the box you created, 

with the lines folded. 

   
  If you resize the text using the handles, the text font size will not change, but the lines will be 

readjusted to fit the text box. 
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  Double click on the text to get its properties. Click on the “…” button to change the font 

characteristics of the text. Mac: The button is called “Show Fonts…”. On the Mac is a Color 
Well, that lets you specify the color of the text. The default is “Text” color, black normally, 
but white if you are using Mac Dark mode. Use option-return to start new lines of text. Win: 
The latest version of the Windows version obeys the color you specified on a Mac, but you 
may not change it. 

   
  You may switch between the two types of text by checking “Size Box to Text” to get resizable 

text, or uncheck it to get text confined to a rectangle. 

Adding Images or.pdf Documents to a Design 
You may include images or .pdf documents to a design. These are for display only and do not 
participate in any actual pipe runs. Image files may be of file extension .jpg, .jpeg, .gif, .bmp, or 
.png. .pdf documents have a file extension of .pdf. 
 • Select External Image/PDF from the Draw Menu, by clicking on the text block icon in the 

tool bar. 
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 • An Open file dialog will be presented. It defaults to select images. If you wish to include an 
image, navigate to the file you want to include and select Open. If you wish to include a .pdf 
document, select PDF files (*.pdf) in the pulldown over the OK and Cancel buttons. You well 
then just see .pdf documents. 

   
 • On clicking Open, the image or .pdf document, will appear, floating with the mouse. (.pdf 

documents may take a few seconds to render.) Click in the drawing to tack it down. Use the 
resize handles to resize it and/or move it to where you want it to appear in the design. Undo 
can be used, if you don’t like it. 

 • A copy of the original image file or .pdf document is saved as part of .tracPipe2 file. If the 
exact same image file is included multiple times, only one copy is saved, even if it was 
included from different locations. 

 • Win: Currently what is displayed in the design is an image version of a .pdf document. This 
means as you zoom in, text may become blurry. (This may be changed in the future.) Mac: 
Since .pdf is a native image format the Mac, it is rendered each time it is displayed at the scale 
it is being viewed. This means text will remain sharp as you zoom in. 

 • Once included in a design, you may use copy and paste to get multiple copies of the image, 
even across design files. 

Adding an Engineering Drawing Title Block to a Design 
 • You can specify the Title Block the one that appears on a standard engineering drawing. This 

appears like so, anywhere you place it. 

   
  To create an Engineering Drawing Title Block, you first have to specify the information that 

goes in it. Select Design Information… under the File menu or by clicking on the  icon on 
the file tool bar. 
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  A dialog will appear that will let you specify the information that can be displayed with the 
drawing. 

   
  A description of the properties is defined under Dialogs, below. 

  Now you can select Title Block under the Block Text icon : 

 
  A rectangle will appear as you move the mouse over the design. Click to place it, Drag it to 

move it, or drag a resize handle to resize it. 

   
   Note: If you try to drop a Title Block on the drawing before using the Design Information… 

dialog, you will get a message: 

   
Regulator Part Number assignment 
In elevated pressure systems, line pressure regulators are required to bring gas pressures down to 
pressures appliances can handle. Pipe sizing operations, BLM or SOPL, will assign OmegaFlex 
regulator part numbers to them that are estimated to be the best fit based on the calculated load,pipe 
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diameters, and appliance type. If an appropriate regulator part can’t be found, pipe sizing will stop 
with an error message. If you’d like to continue, or you don’t like the suggested regulator part 
number, specify your own part number using the Properties dialog for the regulator. Pipe sizing 
can continue. 

Certain appliances, marked High Efficiency, or HE-, must be fed from specific regulators designed 
for use with high efficiency appliances. This is determined by the appliance Efficiency Class; 0 
and 1 for regular appliances and 2 for high efficiency appliances. You may see the efficiency class 
for an appliance by displaying its Properties. Pipes and pipe fittings connected to high efficiency 
appliances reflect the maximum efficiency class of the devices they feed. So will regulators. 

 
Using Sum of Pressure Loss in the design 
Calculated pipe diameters are calculated using the Branch Length Method. This performs a fairly 
conservative calculation to assign pipe diameters. The Sum of Pressure Loss method is more 
sophisticated, by calculating the pressure loss across each section of pipe. These losses are then 
summed between each source (gas meter or regulator) and each end point (appliance or regulator) 
to assure the user defined system pressure drop(s) have not been exceeded. When you incorporate 
SOPL in a design you may manually specify smaller diameters for pipes than the automatic values. 
SOPL will determine whether a smaller diameter will work. Note: “Approved engineering 
methods” such as the SOPL method are allowed per the gas codes (IFGC, NFPA 54, UPC, 
etc.), however, it is recommended the user confirm there are no restrictions on the use of 
specific sizing methods in their jurisdiction. 

To incorporate SOPL, you must place a SOPL Report on the drawing. This will trigger SOPL 
calculations. 

• Select SOPL Report under the Block Text icon : 
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 • A rectangle will appear as you move the mouse over the design. Click to place it, Drag it to 

move it, or drag a resize handle to resize it. 

 
  For each piece of pipe, you will see calculated data about it; the energy load on the pipe (in 

MBTU), the size, the pressure drop/foot, the total drop for the pipe section, and the starting 
and ending pressures. The actual fields displayed are controlled by the Display Defaults 
dialog, under the File menu, and may be fewer than what is described here. 

  If you see the ending pressure on a pipe segment that is much higher than you think is needed, 
you may manually reduce its size and the table will be recalculated. The easiest way to do that 
is to right click on the particular row in the table, and select a size, like so: 

 
  You may also right click on the pipe itself, or use the Properties panel. 
  If the sizing is appropriate, you’ll see the table updated with the new diameter and updated 

data throughout the report. Notice that the pipe size is shown in bold for the pipe, indicating 
that it is manually (explicitly) specified. 

   
  If the resizing resulted in too small a pipe, the pipe or pipes that are too small will be shown 

in red: 
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• To understand the particular problem. click on the resize button to see the error. Use undo to 

undo your change, it may take two, or right-click on the pipe and change its size back to “–
Calculated—". 

Removing the SOPL report will cause future resizes to just use BLM calculations. 

This illustrates the basic procedure for optimizing your design with the help of SOPL. 

Additional Tips 
 • Make a mistake? Cntl-Z will undo operations including sizing. Cntl-Y puts them back. 

• Right click on anything to see a handy shortcut menu for seeing things you can do with that 
object. This includes labels. 

 
 • Double click on anything to see its properties in the Properties Panel or in a special dialog for 

that object. You may use the properties panel to fix things up. If the Properties Panel is already 
showing, you just need to select a single object to see its properties. Mac: This is called the 
Inspector but is quite similar to the Windows version. 

 
 • Object Labels may be moved around or deleted. They may be brought back by right clicking 

on the object the label went with and selecting “label visible” 
 • Select an object and you can use the resize handles to resize it. 
 • Manifolds and other pipe fittings may be reoriented by changing the Orientation property. 
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 • Confused? Hit escape a few times to cancel whatever you’re doing and go to the Select tool. 

It lets you select objects, move them around, delete them etc. 

Drawing by clicking on icons and selecting from menus. 
Another way of working is to use the Buttons in the tool bar and commands in the menu bar to 
select objects to draw or modify. Then use the mouse to place the objects where you want. You 
can add a pipe to connect a new appliance or fitting as you work, or connect them all at once at the 
end. 

Read the section on Tools below, to understand the various buttons available to help you move 
around the drawing, draw, print, and save your work. For example: Hold the shift key down when 
selecting the Pipe tool to draw multiple pipes more conveniently. 
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V. Printing a Design 

Before printing a design, you often need to do some special configuration so the design will appear 
as you would like it on the paper. This is especially true if you want to use a “plotter” or large 
format printer. 

Win: Because of quirks in some versions MS Windows, this may be a little complicated. 

To specify the page size and margins, you need to use the Page Setup command, Cntl-shift-P. If 
you are not using “Letter” size, you’ll want to see the page sizes available for the printer you want 
to print on. In some versions of Windows, Page setup only lets you select sizes from the default 
printer. Other versions, let you select the printer right in Page Setup, that you want to use. In either 
case, it is always wise to see how your document will appear before you print. 

Some plotter drivers are not good about obeying the specifications of the Size in the Page Size 
dialog. You may have to specify the plot size in the specific attributes of that plotter. 

Follow this procedure to print a design: 
 • On Windows systems that don’t let you select the printer, open Windows Control Panel-

>Devices and Printers panel and set the default printer. How you do this may vary, based on 
the particular version of MS Windows you are running on. 

  You may also have to specify attributes (using printer preferences) such as the page size you 
want to print for the specific plotter at this time. 

 • In TracPipe Specifier 2, use the Page Setup command (cntl. shift P) to bring up the Page 
Setup dialog. 

 • Use the Size pulldown to select the particular size of paper you want to use… 
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 • The default margins at 0.5 inch are small for large pieces of paper so you may want to change 
them to maximize the design on the paper, like so… 

   
  Warning! If you flip between Landscape and Portrait, the margins will flip too! 
 •  Now OK the dialog. 
 • Check how the drawing will print using Print Preview… 

    
  The magnifying glass will let you expand the preview. 
 • If you approve of how it looks, it is safe to print the drawing. Use the Print (Cntl. P) command. 

Make sure the printer you want to use is selected. Make sure any special printer options 
are how you want them. 

If you open a new design, or if you relaunch TracPipe Specifier 2, make sure your printer settings 
are still the same. 

Printing in TracPipe Specifier 2 is still being refined. 

Mac: Printing is a little more straightforward on the Mac since drivers are more consistent. 
• We recommend that you always use Page Setup… before you print and specify the specific 

printer you are using, rather than generic. Using generic specifies exceptionally wide 
margins. 
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  Here is an example: 

 
 • If you are printing to a wide format printer, you may want to use a custom page size. Click on 

the Paper Size option and select a custom size, or select Manage Custom Size… to specify a 
special size. If you make a custom size, make sure you specify a margin so your design appears 
in the Printable area of the particular printer you are using. For example: 

 
 • After you set up the page, select the Print command. Click on the Show Details button to see 

a preview of your design on the paper you specified. Like so: 

 
 • Check the preview. If you are using a custom size, occasionally the drawing may be cutoff at 

the right side or bottom. To fix this, cancel the print and go back to Page Setup and specify a 
Scale less than 100%. Usually a very small shrink, like 99%, is all you need to get the drawing 
to fit. 

• If all is well, click on the Print button. 
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 • When you save your design, the last Page Setup is saved with it, so you should not have to 
specify it again, unless you want different options. Notes: On Macs, clicking on the Print 
Preview button brings up the Print dialog, since that contains a preview of your design. Click 
on the PDF button in the Print dialog to create a .pdf version of your design. The Page Setup 
information for Windows and Mac are saved separately in the .tracPipe2 file. 
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VI. Elements in the Design 

Here is an illustrative design showing various features of TracPipe Specifier 2: 

 
There are two highlight colors you should be aware of: Green is the color of selected items. Items 
flagged by the resize algorithm (errors) are show in red. Items that are both selected and 
highlighted are shown is some combination of colors. 

 
VII. The Tools 

At the top of the TracPipe Specifier 2 window, are menus and buttons for accessing all the 
commands for manipulating your design. This section describes these commands. 
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The File Tool Bar 
See the Menu Bar Menus section, below, for fuller descriptions of these commands. More details 
on these may be found in the Menu Bar section, below. 

 Exit (Ctrl. W) 

 New Design (Ctrl. N) 

 Open Existing Design (Ctrl. O) 

 Page Setup (Ctrl. Shift P). Allows the user set the page size and margins for printing. Note: 
before using Page Setup, the user must set the printer they desire to use as the Windows default 
printer, in order to pick an available page sizes for that Printer. Use Windows Control Panel-
>Devices and Printers panel to set the default printer. See Printing a Design above. 

 Print Preview. Shows a preview in a popup dialog. 

 Print Design (Ctrl. P). See Printing a Design above. 

 Cut/Copy/Paste. See the section Using Cut, Copy, Paste. 

 System Properties/Design Information/Display Defaults. Specify the gas supply to the system, 
specify information to display in an Engineering Title Block or set various display defaults. Note: 
If you change the gas source for an existing system, you must manually delete the meter or initial 
regulator in the design and replace with the proper new gas source. 

 Help. Shows application disclaimer. 

The Drawing Tool Bar 
See the Menu Bar Menus section, below, for fuller descriptions of these commands. 

 Undo (Ctrl Z)/Redo (Ctrl Y) 

 Zoom Out (Ctrl -)/Zoom In (Ctrl +) the design 

 Pan (move up, down, left, right) the design. If the drawing window is active, hold down the 
space bar to temporary bring up the pan tool. 

 Select/Move/Delete tool. (Escape Key) 

 Gas source. Presents a pulldown of sources. These are disabled if one is in the design already. 

 Draw Pipes. Hold down the shift key when you select this if you want to draw several pipes in 
a row. When drawing, hold down the shift key (Mac: option key) to draw a direct pipe, that has 
no corner. 



Using TracPipe Specifier 2 28 

 Draw Inline Regulators. Presents a pulldown of Inline regulators—not a propane source 
regulator. These are disabled unless you specify an Elevated gas pressure. 

 Draw Pipe Fittings. Presents a pulldown of Pipe Fittings. 

 Draw Appliances. Presents a pulldown of Appliance choices. 

  Draws free-standing text on the design. See the section on Adding some Additional Text… in 
Quick Start. 

 Draw a block of text or image—a pipe Bill of Materials, a SOPL Report, an Engineering 
Drawing Title Block, image file or .pdf document. 

 

 Shows (double-click) the Properties Panel. If a single object is selected in the design, its 
properties will show in the panel. Selecting a single object will present its properties. Mac: This 
is called the Inspector but functions similarly. 

 Perform Pipe Sizing operations with diagnostics. A dialog pops up when it completes. If it 
found a problem with the design, it presents an error message, and highlights the offending object 
in the drawing so you may correct it. 

 2D/3D drawing modes. 3D mode, which includes drawing in 3 dimensions, and rotating 
the design, is not implemented in this version. 

Menu Bar menus 
1. File Menu 

The file menu contains commands for creating new designs, filing and printing them. 
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New (Ctrl N) 

Creates a new document. A System Properties document is presented asking for the gas 
supply pressure and permitted pressure drop. If there is an open document, it is closed 
after asking if you want it saved. 

Open… (Ctrl O) 
Presents and Open File Dialog for you to select and existing .tracPipe2 document. . If 
there is an open document, it is closed after asking if you want it saved. 

Open TracPipe1 File… 
Like above, but this allows you to open a legacy .tps file created with the original 
TracPipe Specifier for Windows. The file is converted to the latest document type. 

Save (Ctrl S) 
Saves your work. If you’ve never saved your design before, it presents you with a File 
save dialog. 

Save As… (Ctrl Alt S) 
Saves your existing design under as a new file. You’ll be presented with a File Save 
dialog. Further saves will with the new file name. 

Export B.O.M… 
Creates a .csv export of the pipe Bill of Materials. A .csv file is a Microsoft Excel 
compatible ASCII file where each line is a row of the spreadsheet. Columns on each line 
are separated by commas. It has the same layout as the visible B.O.M. when placed on a 
drawing. If you have Microsoft Excel installed on your computer, you should be able to 
just double-click on the .csv file to open it in Excel. 

Design Information… 
Presents a dialog asking for textual information about the design. This information will 
be used as part of a Engineering Drawing Title Block that you can place on your design. 
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See more information on Adding an Engineering Drawing Title Block…, above, and 
under Dialogs below. 

Gas Source Properties… 
Presents the System Properties dialog for specifying supply gas pressure and pressure 
drop. Note: Changing these properties on an existing design does not automatically 
change the pressure source in the drawing or regulators or not. If the gas type changes, 
you must manually change the pressure source in the drawing. Regulators and their kind 
may need to be replaced or deleted depending on the system pressure. Only some of these 
consistencies are flagged. 

Display Defaults… 
Presents the Display Defaults dialog. This allows you set various global defaults for 
displaying labels and objects. See more information in Dialogs below. 

Page Setup… (Cntl Shift P) 
Lets you specify the paper size and orientation you want to print the design on. See details 
on printing in a previous section. 

Print Preview… 
Lets you see a preview of the page as it will be printed. Mac: brings up the Print dialog, 
since that has a preview of the page. 

Print… (Cntl P) 
Prints the design using the default or manually selected printer. The design is scaled to 
the maximum size to fit on the paper with the orientation you specified. See details on 
printing in a previous section. 

Exit (Ctrl W) 
Quits TracPipe Specifier 2. You will be asked to save the drawing if there are outstanding 
changes. This is indicated if the file name in the title has a asterisk at end of the name. 
Mac: (⌘Q) 

2. Edit Menu 
Contains do/undo, cut/copy/paste and some miscellaneous global commands that affect 
the whole design. 

 
Undo (Ctrl Z) 

Undoes the last command. Executing it repeated moves back in time in the undo stack. 
You can completely undo all changes you made since creating or last opening a drawing. 
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Redo (Ctrl Y) 
Moves forward in the undo stack, re-executing commands you undid. 

Cut (Ctrl X) 
Copies selected design items to the paste buffer and deletes them. See the section on Cut, 
Copy, Paste. 

Copy (Ctrl C) 
Copies selected design items to the paste buffer. See the section on Cut, Copy, Paste. 

Paste (Ctrl V) 
Pastes the contents of the paste buffer into the design. The paste buffer must contain 
copies of drawing objects, or plain text copied from other applications. See the section on 
Cut, Copy, Paste. 

Properties (Alt Enter) 
Presents the Properties Panel. If a single object is selected in the design, its properties will 
show in the panel. Selecting a single object will present its properties. 

Calculate Pipe Sizing 
Perform Pipe Sizing operations with diagnostics. Dialog pops up when it completes. If it 
found a problem with the design, it presents an error message, and highlights offending 
objects in the drawing so they may be corrected. 

3. View Menu 
Presents commands the let you change your view of the design. 

 
Home (Ctrl H) 

Zooms and pans the design so the whole design just fills the main window. If you change 
the window size by dragging its sides, issue a Home to re-center the drawing. Mac: Home 
is ⌘-shift-H since ⌘H performs the Hide function. Use ⌘M to minimize a window 
onto the dock. 

Pan (space bar) 
Brings up the Pan tool, so you can re-center the design. If the drawing window is active, 
hold down the space bar to temporary bring up the pan tool. 

Larger (Ctrl +) 
Makes the design larger in the main window about the center of the window. Do this to 
make smaller objects easier to work with. 

Smaller (Ctrl -) 
Makes more of the design fit in the main window about the center of the window. Do this 
to see more of the overall design. 

4. Draw Menu 
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Lets you select an object to draw. 

 
There are submenus for Sources, Regulators, Appliances, Pipe Fittings and various text 
blocks. When you select an item to draw, as you move the mouse over the main window, 
you drag an image or an outline of the object over the drawing. Click the mouse to place 
it. 

After you drop an object TracPipe Specifier 2 will flip to the Select tool. 

Some items may not be placed in the drawing because you may have only one of them or 
they are not allowed, based on the system pressure. Those items will be disabled and can’t 
be selected. 

Pipes work a little differently. After you select a pipe, put the mouse over the point where 
you want to start the pipe and click to place the first point. You can either drag the mouse 
to the new point and release, or release it immediately and re-click the mouse where you 
want the line to end. If you click on a connection point, make sure the point highlights 
red to make sure you make a valid connection. 

If you hold down the shift key while selecting Pipes, the pipe tool will become sticky and 
will stay in the tool until you select another tool or hit escape. See also the section on 
Advanced Pipe Drawing Techniques. 

 
5. Help Menu 

Information about TracPipe Specifier 2. 

 
About TracPipe Specifier 2… 

Presents a dialog with the application version and terms and conditions about using 
TracPipe Specifier 2. 

 

 
VIII. Opening an Existing Drawing 
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Open an existing .tracPipe2 document by double clicking on it or use the Open command. Note: 
Win: Double clicking on a file only works if you have properly installed TracPipe Specifier 2 
using an installer file. 

 
IX. Drawing a Design 

(See the Quick Start guide.) 

 
X. Using the Sizing Tool 

The Sizing tool is the most important operation in TracPipe Specifier 2. It performs three important 
functions: 
 • It checks your design for errors. 
 • It sizes all your pipes first by using the Branch Length Method and optionally, performing 

Sum of Pressure Loss calculations. 
 • It assigns Omega Flex regulator part numbers for regulators on elevated pressure systems. See 

the section Regulator Part Number assignment. 

When the Sizing tool completes successfully it puts up a popup dialog saying that it completed. If 
an error was found, it presents the most important error it encountered and it highlights the 
object(s) that had the error. Errors may be informational or warnings. Sizing continues when these 
errors are encountered. Stronger errors, such as an incomplete design, cause resizing to stop when 
it encounters the error. 

During BLM calculations, the Sizing tool resizes pipes whose default size is marked as 
‘Calculated’, the default. If you are adding to an existing design, you may want to specify the 
actual diameter of existing pipes, so the Sizing tool does not attempt to resize them. If you are 
using SOPL, you may force pipes to be smaller than BLM calculates, but still large enough to pass 
SOPL calculations. 

The Sizing tool will check that these pipes are large enough to handle any additional load in the 
updated design and flag any pipes that don’t, but if using SOPL, it will allow to continue. Pipes 
that fail BLM may pass SOPL. 

If SOPL is being used, pipes that do not provide enough pressure or are out-of-spec are flagged. 

The Sizing tool does check for most errors but may miss a few. New tests are being added with 
new releases of TracPipe Specifier 2. See the Dialogs section below, to see a list of errors that it 
flags. 

 
XI. Outputting your Results 

The two main ways you can output your design are to print the design with the piping Bill of 
Materials on the drawing, and export the Pipe Bill of Materials for import into a spreadsheet. 

 
XII. Dialogs etc. 

 • Gas Source Properties 
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  Lets you show various attributes of the gas supplying the design. 

   
  [Details] 
 • Design Information 
  Presents a dialog asking for textual information about the design. This information will be 

used as part of an Engineering Drawing Title Block that you can place on your design. 

   
  Fields: 

User Name 
The name of the person responsible for this design 

Company Name 
The name of the company the design is for. 

Design Title 
The title of the design. This is not the same as the design filename. 
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Design Number 
A number for the design. 

Revision Date 
The last revision date of the design. 

Design Description 
A one line description of the project. 

Eng. Dwg Size 
Standard engineering drawing sizes: A, B, C, D, E. (For information only. This field does 
not affect the actual page size.) 

 
• Display Defaults 

  Is a dialog that lets you specify how various objects and their labels are displayed in the design 
window and when printed. There is a tab for each object kind. 

   
  Most tabs have common sections: 

Initial Size Multiplier 
This expands or contracts the image used to display the object being laid down in the 
design. So it makes the object appear larger of smaller in the design. It only applies to 
when the object is placed. It does not affect images that are already placed. 

Thickness 
For Pipes, you specify Thickness, the width that pipes are shown in the drawing window 
and when printed. If you are printing to a small piece of paper, what looks fine on the 
monitor may not look great when printed. Use Thickness to make pipes thinner. 

Default Label Font Size 
This specifies the size to display labels for this kind of object. It affects all new and 
existing labels that use the default font size. 
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Label with… 
These are attributes that are to be displayed in all labels for this kind of object. They are 
displayed in the order of this section. Different kinds of objects have different options, 
taken from the list below: 

Source/Appliance/Regulator/Fitting Name 
If an explicit name is specified in the object’s properties, that is used. Otherwise the name 
of the particular kind of source/appliance/regulator/pipe fitting is used. 

Part Number 
display part number if specified or calculated for the part. 

Type — Natural Gas/Propane 
Source gas. 

Supply Pressure 
Supply pressure provided by a gas source. 

MBTU Load 
This is either the load an appliance places on the system, or the load the source/fitting/pipe 
must supply. 

Marker or Pipe Name 
If a pipe has an explicit name supplied in properties, that is used, else it is the pipe letter 
(A, B, C…) assigned to a pipe by TracPipe Specifier 2 

Part Number 
Calculated regulator part number or optional part number supplied by the user. 

Diameter 
Pipe size. 

Length 
The length of the section of pipe. 

Material 
How to display the type of pipe. The options are Full name, or Abbrev… 

Port Size 
For a regulator, this is the diameter of the inlet and outlet ports. 

Outlet Pressure 
The outlet pressure a regulator supplies. 

Order listed in Menu 
The order appliances are listed in Appliance pulldowns. Alphabetical, Home appliances 
in alphabetical order, followed by High Efficiency appliances, followed by Commercial 
appliances. Most Common First, lists them by popularity—a legacy option. 

  B.O.M, SOPL Reports, and Engineering Title Block have their own special options. 
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  For B.O.M. you may specify a single column full B.O.M. or just present the summary section 

which provides pipe totals by pipe type. 
  Two column reports are not yet implemented. 
  You may specify which columns you want to be visible: 

Marker or Pipe Name 
If a pipe has an explicit name supplied in properties, that is used, else it is the pipe letter 
(A, B, C…) assigned to a pipe by TracPipe Specifier 2 

Pipe Size 
Its diameter 

Pipe Type Abbreviation 
The kind of pipe it is. 

Pipe Length 
Pipe length 

MBTU Load 
The gas load the pipe must supply. 

From/To Components 
The source to the pipe, from, and the name of the object it supplies—to. 
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   SOPL report have their own column options: 

    
ID 

If a pipe has an explicit name supplied in properties, that is used, else it is the pipe letter 
(A, B, C…) assigned to a pipe by TracPipe Specifier 2 

Type 
The kind of pipe it is. 

Pipe Length 
Pipe length 

MBTU Load 
The gas load the pipe must supply. 

Pipe Size 
Diameter or the pipe. 

Pressure Drop/Ft. 
The calculated pressure drop/ft. for this section of pipe, based on its diameter, length and 
MBTU load. 

Section Pressure Drop 
Pressure drop/ft * length 

Start Pressure 
The calculated pressure at the source end of the pipe. 

End Pressure 
The pressure at the end of the pipe, start pressure – section pressure. 

Source 
The ultimate gas source, either the system source, upstream pipe outlet, or a regulator 
output. 



Using TracPipe Specifier 2 39 

  The Engineering Title Block has only one display option. Eventually different format 
templates will be available, but only one exists now. 

   
Display Gas Source Conditions 

Normally there is a line in the Title Block that describes the source pressure, pressure 
drop, etc. This may not be desired for certain designs. If not checked the space for this 
field in the block will be left blank. 

 
 • About 
  Tells you what version of TracPipe Specifier 2 you are using and presents a disclaimer of the 

risks and responsibilities of using the product. 

   
 
 • Appliance Load 
  When placing an appliance, this dialog lets you specify the energy consumption in MBTUs. 
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Load 

Remember to specify the appliance load in MBTUs (thousands of BTU) of energy 
consumption, not in BTUs or cubic feet/minute of gas or other energy units. 

 • Source Duplication 
  When adding a new or additional gas sources. This dialog allows you to create a row or 

column of gas sources. This is useful if you are laying out an apartment or large building. 

   
Copies 

This is the number of copies you’d like to create. It must be 1 or greater. The default is 
one. 

Layout 
If more than one is being created, this specifies whether to lay them out horizontally 
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or vertically. 

 
 • Pipe Attributes 
  When completing a pipe, this dialog lets you specify the kind of pipe, its length and it sizing 

properties. 

    
Pipe Type 

This is the kind of pipe. CounterStrike (black jacket) is OmegaFlex’s standard flexible 
pipe, or CSST- Corrugated Stainless Steel Tubing.  TracPipe (yellow jacket) and 
TracPipe PS-II (underground piping) are OmegaFlex’s other CSST products.  Black Iron 
is the classic straight rigid gas pipe.  

This option is sticky. It remembers the last pipe kind you specified as the default. 

Pipe Dia. 
Specifies how you want the pipe sized. The default is to have the Pipe Sizing tool calculate 
the pipe size. If this is an existing pipe, you may want to specify the exact size of the 
existing pipe. 

If you specify an explicit size, the Pipe Sizing tool will warn you if the pipe size is too 
small. 

Length 
Specify the length of the pipe in feet. 



Using TracPipe Specifier 2 42 

 • Pipe Fitting Attributes 
  After placing a pipe fitting, this dialog lets you specify the fitting orientation and if a manifold, 

how many ports it should have. 

   
Orientation 

Fittings may be oriented on the design in different directions, based on the fitting kind. 
The exception is cross fittings, which are symmetrical, so this dialog is not presented. 

Manifold Ports 
When placing a manifold, this lets you specify the number ports the on the manifold. This 
field is disabled, if you are not placing a manifold. 

 • Text Attributes 
  Presented when you double-click on a piece of free-standing text—not object labels, or when 

defining a new piece of text. It lets you define the actual text to display in the design, font 
characteristics, etc. 

   
  Mac: The dialog is slightly different. To enter new lines type option-return since return 

dismisses the dialog. A Color Well lets you specify the color of the text. 
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Font Characteristics 

These are the Font Name, Size, and Style. These are not modifiable in this dialog, click 
on the “…” or “Show Fonts…”button to bring up the standard Windows or Mac font 
characteristics dialog; 

 
After completing or canceling this dialog, TracPipe Specified 2 will switch back to the 
Text Attributes dialog. 

Justification 
Specifies whether you want the text, left justified, right justified, or centered. 

“Size Box to Text” checkbox 
You may switch between the two types of text; text that resizes by dragging its bounds, 
and text that fills a rectangle by folding its lines. Check “Size Box to Text” to get 
resizable text. Uncheck it to get text confined to a rectangle. 

“-- Replace Selection With --” pulldown 
You may bring in certain values into a piece of text by specifying special keywords. 
Examples are the drawing filename, the current date, and values specified in the Design 
Information Dialog. These keywords always start with an ‘&’ character and most are hard 
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to remember. Selecting an item in this pulldown, inserts or replaces text in the text box 
with the correct keyword. The value the keyword represents, replaces the keyword when 
the text is displayed. Values are: 

Company name 
&Company—The Company Name field of Design Information… 

Current date 
&Date—The current date from Windows as Tuesday, May 15, 2018. 

Current time 
&Time—The current time from Windows as 8:24:09 AM. 

Design number 
&Number—The Design Number field of Design Information… 

Design title 
&Title—The Design Title field of Design Information… 

Engineering drawing size 
&EngSize—The Eng. Dwg Size field of Design Information… as A, B…E. This value is 
strictly informational. It does not affect how the design is actually printed. 

Design Revision 
&Revision—The Revision field of Design Information… Usually one or two letters or 
numbers. 

Design revision date 
&RevisionDate—The Revision Date field of Design Information… 

File name 
&Dwg—The name of the saved design file or untitled if it is new. 

Gas kind 
&Gas—Either “Natural Gas” or “Propane” — the kind of gas supplying the system. 

Gas pressure 
&Supply—Gas pressure, in W.C. or PSI, supplying the system. 

Gas pressure drop 
&Drop—The maximum gas pressure drop, in W.C. or PSI, allowed in the system. 

Design description 
&Description—The Design Description field of Design Information… 

Regulator pressure 
&RegPress—The output pressure of standard extra regulators installed in the system. 

Regulator pressure drop 
&RegDrop—The maximum allowed pressure drop in the output of extra standard 
regulators. 

User name 
&User—The User Name field of Design Information… 
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Version build number 
&BuildNumber—The Build Number of the running TracPipe Specifier 2, like 44. 

Version date 
&VersionDate— The date the running TracPipe Specifier 2 was built, like May 12, 2018. 

Version number 
&VersionNumber— The Version Number of the running TracPipe Specifier 2, like 
4.1.1101. 

  Note: Use a period after a keyword, if the text that follows it is an alphabetic character or a 
period you want to show. Like &Dwg.abcdef, or &Dwg..tracPipe2. 

 • Image/.pdf Open File dialog. 
  When including an image or .pdf document, this dialog lets you select the particular file to 

include. 

   
  Use the filetype pulldown, in the lower right hand corner to select whether to select image 

files of .pdf documents. 
 • Sizing Completed 
  Presented when the Pipe Sizing tool completes. If no error was detected a popup dialog is 

shown and disappears after a few seconds. 

   
  Otherwise there are three kinds of errors. Informational errors note about your design that you 

should be aware of. An example of this if a regulator needs a part number. Warnings are for 
limits that are exceeded such as the maximum pressure drop allowed in a system, or a pipe 
diameter could not be calculated. These do not stop calculations. Errors are serious errors that 
stop all calculations, such as a pipe that is not connected to anything or an appliance that is 
not connected. Calculations stop on the first error that occurs. 

  When an error occurs the offending object(s) are usually highlighted in the drawing in red. 
Lines in B.O.M. and/or SOPL reports are show with a red background. 
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  Certain errors that occur during the BLM calculations give the user the option to continue to 

the SOPL phase or to stop. 

   
  These are the errors that can occur and expanded descriptions: 

A supplier is not connected to anything. 
The supply gas meter or regulator is not connected to a pipe. 

If you seem to have a pipe connected but it is dashed, you need to drag the end of the pipe 
until it actually highlights a connection dot on the gas source. 

A supplier has more than one connection 
One connection only, please. 

An object needs to be connected to a pipe. 
An appliance or pipe fitting needs to be connected to the system. 

If you seem to have a pipe connected but it is dashed, you need to drag the end of the pipe 
until it actually highlights a connection dot on the appliance or fitting. 
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A pipe end on object is not connected to anything. 
The object needs to be connected to something. 
An appliance is connected to more than one pipe. 
A gas source is not connected properly. 
A Regulator needs two connections. 
Can't come up with a Part Number for the regulator, 
An object is not connected to a gas run. 
Internal error, could not determine the supply pressure from object. 
Regulator is not appropriate for this gas pressure. 
Could not determine which ends of a regulator is the feed or the supplier. 
Possibly an error in connecting the regulator. 
There is a loop of pipes in a gas run. Stopped at object. 
Pipe has a specified size that is smaller than the calculated value. Specify 
a larger explicit size or turn on "--Calculated--". 
A pipe could not be sized because no sizing table or capacity entry in one 
could be found. 
An error occurred while calculating a Sum of Pressure Loss pressure. An 
appropriate entry in the pressure tabled could not be found, 
An error occurred while calculating a Sum of Pressure Loss pressure. The 
calculated end pressure went negative, 
An error occurred while calculating a Sum of Pressure Loss pressure. The 
maximum allowable pressure drop was exceeded, 
Pipe size is not a valid explicit size for the particular material selected. 
Warning: Pipes must be of decreasing size by type, along a run. 
A pipe has no calculated or explicit diameter to use for SOPL calculations. 
A pipe could not be sized because the pipe length exceeds the maximum BLM 
table entry for this kind of pipe. 
Warning: The pressure drop/foot of pipe must not exceed 10"/ft. W.C. 
Warning: The gas pressure supply to an appliance exceeds ½ PSI or 14\" W.C. 
Unknown Error. 

 


